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Here we will give a brief explanation, with examples for the Computing Techniques.

First to open a new file:

1. Click on the toolbar at the top of your screen.

2. Select Standard LaTeX and then select Blank - Standard LaTeX Article.

3. Choose OK to open a new document.

4. From the View menu, turn on Invisibles, Helper Lines, Input Boxes, and Markers.

Work in the new file:

1. Type I created this equation and press the spacebar.

2. Click to change to mathematics.

3. Type 2x + 3x = 5x.

4. Click to change back to text.

On your screen, you should see this: I created this equation 2x + 3x = 5x.

Entering mathematics
The Math toolbars have buttons for these common mathematical objects:

Unit Big
Fraction Superscript Parentheses Sum Name Operators Matrix Binomial Decoration

Radical Subscript Square Integral Display Brackets Math Label
Brackets Name

Math Templates Math Objects

Just click the button for the object you want, then fill in the template provided.

Examples

Enter a fraction

1. Press Enter to start a new line.

2. On the Math Templates toolbar, click , type 3, press Tab, type 5, and press

the spacebar.

On your screen, you should see this: 3
5

Enter an integral

1. Press Enter to start a new line.
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2. On the Math Templates toolbar, click , type x, click , type 2, and press

the spacebar.

3. Type dx.

On your screen, you should see this:

∫x2dx

Computation
To evolute this integral use the computational engine from the Compute toolbar:

Solve Plot 3D Show
Evaluate Exact Expand Rectangular Definitions

Evaluate Simplify Plot 2D New
Numerically Rectangular Definition

With the insertion point in or at the end of the expression ∫x2dx, click .

The computational engine performs the integration. On your screen you should see this

result:

∫x2dx = 1
3
x3

To evaluate a definite integral

● Place the insertion point in the expression and choose Evaluate or Evaluate
Numerically.

 Evaluate, Evaluate Numerically

∫
0

1
x2 x3 + 1 dx = 4

9
2 − 2

9
= 0.40632

 Evaluate Numerically

∫
0

1
x2 x3 + 1 dx = 0.40632

To find the derivative of a function, we can use a variety of notations, including the forms:

d
dx

, dn

dxn
, Dx, Dxx, Dx2 , Dxy, Dxsyt ,

∂
∂x

, and ∂n
∂xs∂yt

 Evaluate

d
dx
x3 = 3x2

d4

dx4
3x8 = 5040x4

Dx5y2x
9y3 = 90720x4y

∂
∂x 

sin2xcosx = 3
4
sin3x − 1

4
sinx
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Defining Variables and Functions
You can assign a value to a variable with Definitions + New Definition.

To assign the value 25 to z for deferred evaluation

1. Type z = 25 in mathematics.

2. Leave the insertion point in the equation.

3. Click the New Definition button on the Compute toolbar.

For example, evaluating the expression “3 + z” returns “= 28.”

Functions of One Variable

To define the function f whose value at x is ax2 + bx + c

1. Enter the equation fx = ax2 + bx + c.

2. Place the insertion point in the equation.

3. Click the New Definition button .

 Definitions + New Definition

fx = ax2 + bx + c

 Evaluate

ft = at2 + bt + c

f ′t = 2at + b

Creating Matrices
To enter a matrix

1. On the Math Objects toolbar, click or, from the Insert menu, choose Matrix.

2. In the Matrix dialog box, set the dimensions and baseline of the matrix.

3. Choose OK

For example a 2 × 2 matrix A =
a b

c d
.

To compute the determinant of a square matrix

1. Place the insertion point in the matrix.

2. From the Matrices submenu, choose Determinant.

a b

c d
, determinant: ad − bc
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Solving Polynomial Equations
There are four options on the Solve submenu: Exact, Integer, Numeric, and Recursion. The

option Exact is general in nature and is used in most situations.

Equations with One Variable
To solve an equation with one variable

1. Place the insertion point in the equation.

2. Click or, from the Solve submenu, choose Exact.

Your system returns an explicit or implicit solution.

Solve + Exact

5x2 + 3x = 1, Solution is: − 1
10

29 − 3
10
, 1
10

29 − 3
10

5x2 + 3x = 1.0, Solution is: −0.83852,0.23852

x3 − 3x2 + x − 3 = 0, Solution is: 3,−i, i

When there are multiple solutions, only distinct solutions are displayed.

 Solve + Exact

x − 53x + 1 = 0, Solution is: −1,5

Systems of Equations
You can create a system of equations either by entering equations in a one-column matrix or

by entering equations in a multirow display.

To create a system of equations using a matrix

1. Click or, from the Insert menu, choose Matrix.

2. Set the number of rows equal to the number of equations.

3. Set the number of columns to 1.

4. Choose OK.

5. Type the equations in the matrix, one equation to a row.

To create a system of equations using a display

1. Click or, from the Insert menu, choose Display.

2. Type the equations in the display, one equation to a row, adding rows as needed
with the enter key.

To solve a system of equations

1. Create a system of equations.

2. Leave the insertion point in the system.

3. Click or, from the Solve submenu, choose Exact.

4. If a dialog box appears asking Variable(s) to Solve for, type the variable name(s)
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in the box, separated by commas.

Following are some examples for systems of two equations.

Solve + Exact

2x − y = 5

x + 3y = 4
, Solution is: x = 19

7
,y = 3

7

x2 − y2 = 5

x + y = 1
, Solution is: x = 3,y = −2

x2 − 3y = 7

6x + 4y = 9
, Solution is:

x = 1
4

301 − 9
4
,y = 45

8
− 3
8

301 , x = − 1
4

301 − 9
4
,y = 3

8
301 + 45

8

When the number of unknowns is larger than the number of equations, you are asked to

specify variables in a dialog box.

Solve + Exact

2x − y = 1

x + 3z = 4
, Variable(s) to Solve for: x,y, Solution is: x = 4 − 3z,y = 7 − 6z,

2x − y = 1

x + 3z = 4

w + x = −3

, Variable(s) to Solve for: x,y,z, Solution is:

x = −w − 3,y = −2w − 7,z = 1
3
w + 7

3

Numerical Solutions
You can use Numeric on the Solve submenu. This gives all solutions, both real and complex,

to a polynomial equation or system of polynomial equations.

Solve + Numeric

x2 + 7x − 5.2 = 0, Solution is: x = 0.67732, x = −7. 6773

x3 − 3.8x − 15.6 = 0, Solution is:

x = −1. 5 + 1. 7176i, x = −1. 5 − 1. 7176i, x = 3.0

x2 + y2 = 5

x2 − y2 = 1
, Solution is: x = −1. 7321,y = −1. 4142,

x = −1. 7321,y = 1. 4142, x = 1. 7321,y = −1. 4142,
x = 1. 7321,y = 1. 4142
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Inequalities
To solve an inequality

1. Leave the insertion point in the inequality.

2. From the Solve submenu, choose Exact.

 Solve + Exact

16 − 7y ≥ 10y − 4, Solution is: −∞, 20
17

x3 + 1 > x2 + x, Solution is: −1,1 ∪ 1,∞

|2x + 3| ≤ 1, Solution is: −2,−1

7 − 2x
x − 2 ≥ 0, Solution is: 2, 7

2

Ordinary Differential Equations
With the choices on the Solve ODE submenu you will be able to find closed-form solutions to

many differential equations. The solution is generally returned as an equation in yx and x (or
whatever variables were specified) with any arbitrary constants represented as C1,C2, . . . ,Cn.

To solve a differential equation

1. Type the differential equation using standard mathematical notation.

2. With the insertion point in the equation, from the Solve ODE submenu, choose
Exact, Laplace, Numeric, or Series.

Exact Solutions
Two methods, Exact and Laplace, return exact solutions to a linear differential equation.

Exact Method

To solve a differential equation by the Exact method place the insertion point in the

differential equation and choose Solve ODE + Exact.

Solve ODE + Exact

dy
dx

= xy, Exact solution is: C1e
1
2
x2

Solve ODE + Exact

y′′ + y = x2 (Independent Variable: x), Exact solution is:

C1 cosx − C2 sinx + x2 − 2

Laplace Method

To solve a differential equation by the Laplace method

Solve ODE + Laplace

dy
dx

= y, Laplace solution is: exy0
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Solve ODE + Laplace

y′3 − 3y′2 + 2y′ = 0, Laplace solution is:

y0 + 3
2
ℒ−1 1

s12
ℒ

∂yx
∂x

2
− 1

2
ℒ−1 1

s12
ℒ

∂yx
∂x

3

Series Solutions
Solve ODE + Series

Dxy = y, Series solution is:

y0 + xy0 + 1
2
x2y0 + 1

6
x3y0 + 1

24
x4y0 + Ox5

y′ = sinx
x (Independent Variable: x), Series solution is:

y0 + x − 1
18
x3 + 1

600
x5 + Ox7

dy
dx

+ y = e−x
2

, Series solution is:

y0 − xy0 − 1 + x2 1
2
y0 − 1

2
− x3 1

6
y0 + 1

6
+ x4 1

24
y0 + 1

24
+ Ox5

Creating 2D and 3D plots is simple
You can create 2D and 3D plots of polynomials, trigonometric functions, and exponentials.

You can create 3D implicit plots and animated 2D and 3D plots. You can plot the results of your

computations and add values to the plots.

The plotting commands appear on the Compute menu or the Compute toolbar.

To plot an expression involving a single variable

1. Enter the expression in your document.

2. With the insertion point in the expression, click the Plot2D Rectangular button

on the Compute toolbar or, from the Plot 2D submenu, choose Rectangular.

Plot 2D + Rectangular

x sin 5x

-4 -2 2 4
-1

1

2

3

4

x

y

y = x sin 5x
Add the caption y = x sin 5

x by typing it into the Plot Properties + Labeling dialog in the

Caption Text entry field.

To add an expression to a plot

● Select the expression with the mouse and drag it onto the plot.

or
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● Choose Add Item in the Items Plotted page of Plot Properties dialog and type or
past the expression in the Expressions and Relations box.

The following example plots x sin 1
x together with its envelope x and −x.

Plot 2D + Rectangular

x sin 1
x

x (Select and drag to the frame.)

−x (Select and drag to the frame.)

-1.0 -0.5 0.5 1.0

-1

1

x

y

y = x sin 1
x , y = x, y = −x

Implicit Plots
The equation of a circle cannot be rewritten as a function of one variable. You can, however,

plot the set of points satisfying such an equation using the 2D implicit plot feature.

To plot an equation

1. Enter the equation.

2. With the insertion point in the equation, from the Plot 2D submenu, choose
Implicit.

The Plot Intervals for the following plots were set to −3 ≤ x ≤ 7 and −2 ≤ y ≤ 8.

Plot 2D + Implicit

x − 22 + y − 32 = 25

-2 2 4 6

5

x

y

-2 2 4 6

5

x

y

-10 10

-10

10

x

y

The second and third views of this figure are made as follows. To make the figure look like

the circle it is, on the Axes page of the Plot Properties dialog, check Equal Scaling Along Each

Axis. For a more distant view of this circle with the Plot Intervals unchanged, on the View page of

the Plot Properties dialog, uncheck Default for View Intervals and change them to −6 ≤ x ≤ 10
and −6 ≤ y ≤ 10. This example illustrates the difference between Plot Intervals (in this case,
−3 ≤ x ≤ 7 and −2 ≤ y ≤ 8) and View Intervals (in this case, −6 ≤ x ≤ 10 and −6 ≤ y ≤ 10).

8



Polar Coordinates
In polar coordinates, you specify a point P by giving the angle θ that the ray from the origin to

the point P makes with the polar axis and the distance r from the origin. The equations that relate

rectangular coordinates to polar coordinates are given by

x = rcosθ and y = r sinθ

or equivalently,

x2 + y2 = r2 and tanθ =
y
x

To make a plot in polar coordinates

1. Type an expression for the radius in terms of the angle θ.

2. With the insertion point in the expression, choose Plot 2D + Polar.

To obtain the view shown in the following two plots, select the frame and choose Edit +

Properties. Click the Axes tab, check Equal Scaling on Both Axes, and choose OK.

Plot 2D + Polar

sin2θ 1 − cosθ 1 − sinθ + 2sin3θ

-0.6 -0.4 -0.2 0.2 0.4 0.6

-0.6

-0.4

-0.2

0.2

0.4

0.6

x

y

sin2θ

-2.0 -1.5 -1.0 -0.5

-1.0

-0.5

0.5

1.0

x

y

1 − cosθ

-2 -1 1 2

-4

-3

-2

-1

1

x

y

1 − sinθ + 2sin3θ

3D Plots of Functions and Expressions
You can plot a wide variety of surfaces with Plot 3D. Examples of Rectangular, Cylindrical,

Spherical, and Implicit plots are presented in this section.

To plot an expression involving two variables

1. Enter the expression in your document.

2. Place the insertion point in the expression.

3. Click the 3D Plot button on the Compute toolbar or, from the Plot 3D

submenu, choose Rectangular.

Plot 3D + Rectangular

sinx + cosy
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3D Plot Cylindrical
The following example shows a plot of the cylinder r = 1 and a cone r = 1 − z, obtained as the

3D cylindrical plot of the expressions 1 and 1 − z, with 0 ≤ θ ≤ 2π, and 0 ≤ z ≤ 1.
Plot 3D + Cylindrical

1

1 − z

3D Plot Spherical
A sphere and a cylinder can each be plotted as a function of the radius. Following is a sphere

of radius 2. Set 0 ≤ θ ≤ 2π and 0 ≤ φ ≤ π, check Equal Scaling on Each Axis, and choose Color
Patch for Surface Style.

Plot 3D + Spherical

2

Implicit Plots
You can plot an equation involving three variables with Plot 3D Implicit. You will find the

Switch Variables option in the Plot Components tabbed dialog useful when the variables are not

interpreted as you intended.

To obtain an implicit plot of an equation involving three variables
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1. Enter the equation in your document.

2. Choose Plot 3D + Implicit.

The next example shows a 3D implicit plot of x2 + y2 + z2 + 1 = x + y + z + 12 with Boxed
axes, Domain Intervals −5 ≤ x ≤ 5, −5 ≤ y ≤ 5, and −5 ≤ z ≤ 5, Turn set at −30, and Tilt set at 78.

Plot 3D + Implicit

x2 + y2 + z2 + 1 = x + y + z + 12

Statistics
You can perform statistical operations on data with the various items on the Statistics

submenu.

To view Statistics menu items

● From the Compute menu, choose Statistics.

The items Mean, Median, Mode, Geometric Mean, Harmonic Mean, Mean Deviation,

Moment, Quantile, Standard Deviation, and Variance on the Statistics submenu take a single

argument that can be presented as a list of data or as a matrix. The result of an operation is a

number or, in the case of a matrix or vector, a number for each column.

The items Fit Curve to Data, Correlation, and Covariance on the Statistics submenu take a

single argument that must be a matrix. For the multiple regression curve-fitting commands, the

columns must be labeled with variable names.

Here some examples

To find the median of a set of numbers

● Place the insertion point in a list or set of data, a vector, or a matrix, and from the
Statistics submenu, choose Median.

 Statistics + Median

1,5,2, Median(s): 2

4.5,−2.6,7.9, 5. 9, Median(s): 4. 5

To compute the mean deviation of a list, vector, or matrix column

● Place the insertion point in a list, vector, or matrix and from the Statistics submenu,
choose Mean Deviation.

Statistics + Mean Deviation
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1,2,3,4, 5, Mean deviation(s): 6
5

2 3 , Mean deviation(s): 1
2

−85 −55 −37

−35 97 50
, Mean deviation(s): 25,76, 87

2
.

Exercise
Open new SWP file, write your name.

Q1 Evaluate each of the following

1. ∫1 − csc tcot tdt

2. sin3 + cos30∘ − ln105
log1013

Q2 Plot the following

1. x − 52 + y + 32 = 16, 0 ≤ x ≤ 10.

2. Sphere with ρ = 2.5

Q3 Define the functions

fx = x2 + x, gx = x + 1

Evaluate the following

1. fg2

2. fx ∘ gx

Q4 Given

A =

1 2 2

1 4 3

1 3 6

, B =

3 3

4 33

1 5

1. Find the inverse and eigenvalues of A.

2. Evaluate AB.
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